“SEADA G44 User Guide

Showing the World

This user guide provides basic instructions for setting up SEADA G44 video wall controllers using its
management software.
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1. Product Introduction

1.1. Product profile

G44 video wall controller can support up to 4 inputs/4 outputs.

It supports HDMI, DVI, VGA, YPbPr, CVBS signal input/output through DVI-U jacket.

It support RS232 communication interface, through the special PC tool to control the matrix
signal switching, monitoring the working state of the matrix, set the signal resolution, etc..
Seamless switching available;

1.2. Product capability

Support 4 inputs and 4 outputs, 4 L/R audio inputs and 4 L/R audio outputs;
Support HDMI/DVI, VGA, YPbPr, CVBS input;

Support HDMI/DVI, VGA, YPbPr, CVBS output;

Support a maximum resolution of 1600 x 1200@60hz;

Support RS$232 port control

Support network port control

Support IR remote control

Support front panel button control

Scalar inside, output resolution control available;

1.3. Specification & Parameters

Interface Signal
HDMI HDMI -1.3
DVI DVI 1.0
Input VGA 800x600,1024x768,1280x768,1280x800,1280x1024,136
DVI-U 0x768,1400x1050,1600x1200,1920x1080

YPbPr 576i50,720p50,720p60,1080i50,1080i60,
1080p50,1080p60

CVBS PAL, NTSC

Interface Signal

HDMI HDMI V1.3A
1024x768,1280x1024,1360x768,1280x720
1600x1200,1920x1080,1680x1050

DVI DVI 1.0

Output BVI_U 1024x768,1280x1024,1360x768,1280x720

1600x1200,1920x1080,1680x1050

VGA 1024x768,1280x1024,1360x768,1280x720
1600x1200,1920x1080,1680x1050

YPbPr 1080p60, 720p60

CVBS PAL/NTSC

Control RS232 D-sub 9 | Baud rate: 9600
Size W*D*H 430 (mm) x220 (mm) x44 (mm)

www.seada.co.uk
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DC 12V/3A power adapter
Power Power 25W

consumption
Operating 0°C—40°C
temperature

Temperature
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2. Hardware Overview

G44 User Guide

Model: G44-DVI

Shawing the Wodd
44 VIDED WALL CONTROLLER
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1 - Display

2 —Input Buttons

3 — Output Buttons
4 — Function Buttons
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3.76 mm H

Back Panel includes 4 DVI-U Inputs and
Outputs, Ethernet control port, 2x Serial ports
and 4 3.5 mm captive screw connectors for
audio inputs and outputs
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3. G44 Software

Il Password Authentication eSS ysers can run the Ga4d.exe software directly without
installation. It requires password authentication:
Account [Administrator v] Default password for Administrator is: 111111

Default password for User is: 000000

Password

There are 7 main tabs in this software: Matrix Switch, Advanced Switch, Signal Setting, Fine Tune, OSD
CTRL, TV Wall, Network Setting.

. Matrix PC tool-VM44-v3.0.112

Matrix Switch |Advanced Swi|ch| Signal Settil\gl FineTune:PQ&Position| OSD CTRLI v Walll Network Setting

Input! | Input2 | Input3 | Inputd
a1 .2 a3 ~4

Video-Output3

Video-Outputd

Allset Inputl v Recall Model v SaveAs/Model v

Ctrl Mode

QOUART @Network  Port v Status EDID Note: Please WAIT unitl all info reading success!

Reading: Output Port2 -> Signal Resolution success A
Device Name IP Address MAC Address Version Readf"g: Sl ngna‘ e

Reading: Output Port3 -» Signal Resolution success
K3 192.168.0.247 A6 4C 5E E3 BF D7 3015

Reading: Output Port3 -> Signal Resolution success
Reading: Output Portd -> Signal Type success
Reading: Output Portd -> Signal Resolution success
Reading: Output Port4 -> Signal Resolution success
Reading: Screen Combine success

Reading: All Information success!
.

3.1. Matrix Switch
Users can configure the G44 device and connect the device to control PC in this section.

3.1.1. Connect to the G44 via UART
Connect the G44 to the control PC with a serial cable

; . Port |COM4 -
1. Click the dropdown menu right of Port to select the COM port. ° -

2. Click the button right of Status to connect to the device (the button will change from

Disconnected to Connected) ——

3. If the COM port does not exist, then the PC tool will show a [Matrixpcooiviosos )
message of ‘COM x not detected!’. If this message occurs, you .
should start from step 1 after you connect a serial cable to the ‘0' COME not detected!
computer.

www.seada.co.uk
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4. If the device or the connection is faulty, then a message will “Matri PC tool-v1.0804
occur as follows after 3 seconds. Please check if your device or
hardware connection is correct.

e
[0I device response timeout
-

5. Ifallis rlght, the PC tool will read some information Naote: Please WAIT unitl all info reading success!

from the device. It probably takes 5 seconds and it will ezalngr S Peamall = fgpall Resainien snzaess
Reading: Output Board3 -= Signal Type success

show IReading: All information success!” when Reading: Output Board3 -= Signal Resolution success

.. Reading: Output Board3 -= Signal Resolution success
finished. Reading: Output Board4 -= Signal Type success

Reading: Output Board4 -= Signal Resolution success
Reading: Output Board4 -= Signal Resolution success
Reading: Screen Combine success
Reading: All Information 5ucce55!|

3.1.2. Connect to the G44 via Network
The default IP address for G44 controller is 192.168.0.247 Users need to change the IP address of
the control PC to the same network segment as the G44.
o Change the ‘Obtain an IP address automatically’
to ‘Use the following IP address’ to set up a static IP address of TCP/IPv4 in Ethernet Properties
>|P address: any address between 192.168.0.2 and 192.168.0.254 except the address which has
been taken by the G44
>Subnet mask: 255.255.255.0, Default Gateway: 192.168.0.1
o Once the control PC IP address having been set up, connect PC to either the RJ45 ports of
G44 controllers via a network cable and then press the Connect button to connect the device.

3.1.3. Matrix Switch Routing .
) ) . . Inputl Input2 | Input3 | Input4
Users can switch and assign different inputs to the -1 -5 -3 -4
selected outputs in the matrix. The name of the
input/output can also be changed by selecting the
default name — Input1/Video-Outputl and
replacing it with the chosen name. Video-Output3
Video-Outputd

Video-Outputl —

Video-Output2

3.1.4. Allset, Recall, Save As and Reset

The G44 unit has 32 modes (or Allset  Inputd v Recall Model v  SaveAs Model v

presets) already saved. Selecting
one of them from the recall Menu will select that specific preset.

If you would like to save a preset you have already created, select the dropdown menu and choose
which slot you want to save it in.

Finally, the Allset dropdown menu helps the users select a single input to be displayed on all of the
screens (i.e. Allset Input 4 would display Input 4 on Output 1, Output 2, Output 3 and Output4.)

_____________________________________________________________
“SEADA

m. |
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The reset button, resets the default settings of the unit — Input 1 mapped to Output 1, Input 2
mapped to Output 2 etc. (Including the audio)

3.1.5. Presentation Mode

From the dropdown menu in the top-right corner, users can select either Matrix mode or
Presentation mode.

e Matrix Mode — The Inputs and their audio source are mapped to each other. Meaning that
Input 1 will have the audio source from Input 1, Input 2 will have the audio source from
Input 2 etc.

e Presentation Mode — This allows the user to control the audio source separately — The video

screen can display input 2, however the audio source can be any of the inputs (including
input 2)

[l Matrix PC tool-VM44-v3.0.112

Matrix Switch | Advanced Switch | Signal Setting | FineTune:PQ&Position| OSD CTRL | TV Wall | Network Setting — ion M ~

Inputl  Input2 Input3 Inputd Inputl  Input2 Input3  Inputd

-1 -2 -3 -4

Video-Output1

Audio-Output1

Video-Output2

Video-Output3 E
Audio-Output2

Video-Outputd

Audio-Output3
Control @ Video/Audio O Video+Audio

Audio- t4
Allset Inputl  ~  Recall Model | SaveAs Model udio-Outpu

Ctrl Mode
OUART @Network  Port ~|  status Pisconnected] EDID Note: Please WAIT unit all info reading success
Reading: Outpot Port2 > Signal REsoliBion suctess ~
Device Name 1P Address MAC Address Version Reading: Output Port3 -> Signal Type success
Reading: Output Port3 -> Signal Resolution success
K3 192.168.0.247 AG4CSEE3BFD7 3015

Reading: Output Port3 -> Signal Resolution success
Reading: Output Port4 -> Signal Type success
Reading: Output Port4 -> Signal Resolution success
Reading: Output Port4 -> Signal Resolution success
Reading: Screen Combine success

Reading: All Information success!

Video and audio can be controlled separately(default):

Control@ Video/Audico () Video+Audio

Video and audio can be controlled together. And then you can select which audio channel will be
controlled.

Control ) Video/Audic @ Video+Audio Audio Choice
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Audio route

Audio-Outputl
Audio-Output2

Audio-Output3

Audio-Outputd

Click to control audio route. And the blue button represents current route information.

NOTE: Audio output X has two type (L/R and Inner).

3.2. Advanced Switch
The PC tool support automatically switch the input source periodically for the output port in order to
facilitate the demonstration functions needed in some scenarios.

Operation guide is as follows:

1. Click the output port that needs configuring ( Also we can press ‘Ctrl’ or ‘Shift’ first, then click to

select more output ports )

Matrix Switch Advanced Switch I Signal Setting l FineTune:PQ&Position| OSD CT RL] TV Wall I Network Setting

Usage note: 1. Add input to output 2, Tick output and then start sending loop

Input Custom name Output Custom name Input Signal
Input 1 - [] Output 1 -

Input 2 - El Output 2 -

Input 3 - [7] Output 3 -

Input 4 = [f] O;Jtput 4 -

s

Input 5 - [7] Output 5 -

Input 6 = [7] Output 6 e

Input 7 - [ Output 7 -

Input 8 - [7] Output 8 -

www.seada.co.uk
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2. Press ‘Ctrl’ or ‘Shift’ first, then click to select input ports

Matrix Switch Advanced Switch I Signal Setting | FineTune:PQ&Position| OSD CT! RLI TV Wall I Network Setting

Usage note: 1. Add input to output 2. Tick output and then start sending loop

Input Custom name Output Custom name  Input Signal
Input 1 - [7] Output 1 -
Input 2 - [j Output 2 -
Input 3 - [7 Ouf:put 3 -
Input 4 - \[] Output 4 -
Input 5 - [ Output 5 -
Input 6 : "] Output 6 -
input 7 - [7] Output 7 -
Vlﬁnput 8 - [7] Output 8 -

3. Click “-->" button to add the input ports selected in step 2.
Matrix Switch Advanced Switch | Signal Setting ’ FineTune:PQ&Position| OSD CTRLI TV Wall I Network Setting

Usage note: 1. Add input to output 2. Tick output and then start sending loop

Input Custom name Output Custom name | Input Signal
Input 1 - ‘ ] Output 1 - | Input 1,2,3.4,6,8
Input 2 : | [ Output 2 - |
Input 3 = ] Output 3 ; | Input 1,2,3.4,6,8
| Input 4 - |[7] Output 4 - Input 1,2,3,4,6,8
Input 5 - F] Output 5 - —
[] Output 6
Input 7 - [] Output 7
Inbut 8 - [T] Output

4. Check the output ports that need to automatically switch input source periodically.

Matrix Switch Advanced Switch | Signal Setting | FineTune:PQ&Position| OSD CTRLI TV Wall I Network Setting
Usage note: 1. Add input to output 2. Tick output and then start sending loop
Input Custom name | Output Custom name Input Signal
Input 1 E— V] Output 1 | z Input 1,2,3,4,6,8
Input 2 - | [T 6ufbut 5 - e -
Input 3 ? | ¥ Output 3 | 2 Input 1,2,3,4,6,8
| Input 4 - \ (V| Output 4 - Input 1,2,3,4,6,8
Input 5 - [ | Output 5 -
| Input 6 - 1 [7] Output 6 -
]nput 7 S ["] Output 7 =
l"lgéu; 8 - ‘ [T] Output 8 -

5. Configure automatically switch Switch frequency: default 2000ms

www.seada.co.uk
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All outputs send combine: default not checked
unchecked: Switch all outputs one by one.
checked: Switch all output ports’ input at the same time in a switch operation.

Note: Switch one input one by one if there’re many input ports selected.

Wait others finished then start next loop: : Only can be set when ‘All outputs send combined’ is

checked
unchecked: When the number of the selected input ports of some output is not the same,

immediately start next loop when one output finished a switching loop.
checked: All outputs start a new loop together. When the number of the selected input ports
of some outputs is not the same, not start next loop until other outputs finish theirs current

switching loop.

Send cmd only one loop: stop automatically switch when a loop is finished.
Select all outputs: Quickly check or uncheck all output ports.

@ Send cmd periodly at  |2000 | ms

[ All outputs send combined

Wait others finished then start next loop
["1Send cmd only one loop

|| Select all outputs

6. Click ‘Start’ button to start automatically periodically switch.
Automatically periodically switch is ongoing...
Click ‘Stop’ button to stop automatically periodically switch when needed. If ‘Send cmd only one
loop’ is checked, it will stop after one loop is finished.

www.seada.co.uk
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3.3. Signal settings
In the signal settings tab, the user can see the Input Resolution and Input Type as well as the Output
Type and Resolution. The read all function will recognize the type and resolution automatically,
however if the user wants to change the input resolution, then you can adjust it manually via the
dropdown menu.

Additionally, you can also manually read one Input/Output at a time — pressing the read button next
to the selected input will only read that input alone.

Il Matrix PC tool-VM44-v3.0.58 — ] X
Matrix Switch Signal Setting I FineTune:PQ&Positionl 0SD CTRL] TV Wall I
—Input Port—| Read All Output Port—| Read All
Label Input Type Input Format Label Output Type Output Format
1 pvi v/ [1280x720p60 1 |[Homi | 1920x1080060
2 pvi | [1280x720p60 2 [HoMI  ||1920x1080p60
3 |pvi v | |1280x720p60 3 |HDMI V| |1920x1080p60 v
4 pvi v | |1920x1080p60 Read 4 |HDMI v 1920x1080p60 -
3.4.FineTune: PQ & Position
[l Matrix PC tool-VM44-v3.0.58 -
Matrix Switch | Signal Setting FineTune:PQ&Position | 0sD CTRL | Tv Wall |
Select PQ FineTune Port— Outputl v Select Position FineTune Port— Qutputl v

Read the input source

CVBS/YPbpr or HDMI/VGAB&1080P/720P/1024x768 position adjust

HStart ¥

Brightness ¥
Contrast ¥
Saturation ¥

Sharpness ¥

LU

Vstart ¥
Cool Read Hsize ¥
VSize ¥

Read | Reset

ON || oFF

LU UL

[ ]
[ ]
[ ]
[ ]
[ ]
[ ]
*
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3.4.1. PQ Control

This section highlighted in red allows the user to fine-tune the settings of their screen from the G44
software.

The dropdown menu at the top of the section allows the user to select which screen to apply the
settings to

The read option reads the settings of the monitor/screen that are already in place and adjusts the
values in the software, while the reset button will reset the settings to their default after they have
been manually adjusted.

3.4.2. Position Control
The section highlighted in blue allows the user to fine-tune the position of their screen. Parameters
such as H Start V start, and H Size and V Size will allow the user to adjust the starting position and
the size of the screen (H — Horizontally, V - Vertically)

The dropdown menu at the top of the section allows the user to select which screen to apply the
settings to

The read option will read the monitor/screen settings that are already in place and adjust the values
in the software and the reset button will reset to the default values after the values have been
manually adjusted.

3.5.0SD Control

. Matrix PC tool-VM44-v3.0.112 - m} X

Matrix Switl:hl Advanced Switch | Signal Setting I FineTune:PQ&Position OSD CTRL | TV Wall | Network Setting

Board Address | Output! ~ Text Content
Display ;{ } Text mode  3x3 v
Transparent 3 | iﬂn‘:’!” '
Alpha 50 v 4l | 13:47:55
reccoo N EE ve- :: } tine 4
sackcolor D | R More 7] |
\

Relative Left Up Set 8 I Self-Clocking []
Fort [Se V] 5] [5e] [Fesd] [impon] [Bpor] [Fet]
Current Date|2019/11/12 Mode 1 ~ Mode 1
Current Time|13:47:55
Device Date Time

www.seada.co.uk
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3.5.1. Text Content

There are several modes of OSD — Normal, 3x3 and s
3x4. Ayop Text mode Normal +

2019/06/:
With the normal mode there will be only one column

displayed at a time. Normal mode allows for more

Line 3

11:32:34

lines to be added as well. Simply press enter to go to e Line 4
a new line date ever[1__|
3x3 and 3x4 modes add additional columns that can e Til;ne:
be displayed on the OSD. e e e e e =

3x3 — Repeats the Text Content 3 times in 3 columns Mdett ¥ e i

3x4 — Repeats the Text Content 3 times in 4 columns

When the Sync Time checkbox is ticked, then the date and time will be displayed. The user can select
on what line both the Date and the Time to appear and what their format is.

Additional settings can be found underneath for the time update settings. The “Update Every __ sec”
setting will tell the OSD how often to update the time (every 1 second functions like a digital watch
and updates every second, while anything over 1 second will update only as often as specified by the
user)

e Set - This will apply the current settings for the OSD Text Content and will display it onto the
screen

e Read - This function will read any existing OSD settings on the screen.

e Import — This allows the user to import any OSD settings from another control PC (Any
settings that have not been saved on the device itself)

e Export — The user can export any of the OSD settings from this software into an .osd file

e Reset — This resets the OSD settings to factory default.

The mode save and mode load settings allow the user to load a pre-existing OSD preset and to save
the current one into one of the 8 slots (Note: These mode slots are different than the Matrix Switch
modes and there are only 8 of them)

www.seada.co.uk
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3.5.2. Text Settings

The user can apply the OSD settings to one
screen at a time. The Board Address dropdown
menu dictates which screen is the OSD being
setup on.

Display will hide or show the text

Transparent when selected off will apply a solid
background to the text so that it is more easily
readable. When selected on it will remove the
solid background and only the text will remain.

G44 User Guide

Il Matrix PC tool-VM44-v3.0.58

Matrix Switchl Signal Setting I FineTune:PQ8Position OSD CTRL ITV Wall ]

Board Address i Outputd ~

Displayi ON

Transparent |

ON
Alpha 2ssl v
Text Color ;- | ] . | More
peround coor | N N I | oo
Position i Relative v Horizon Righ v Vertical Dow v

|
Fot | SimHei | |32:32

V

The alpha slider dictates how opaque the text is — 0 being invisible and 255 being 100% opacity.

Text Color will change the color of the text only. This setting has 5 color slots, however when clicking
the dropdown menu and clicking on one of the 5 colors, it will select that slot and open the following

menu:

Color

[na]
1]
)
o
[+)
2
=)
o

m

HEENTT
HEERNTAT

')
=
‘
=1
3
o
=%

177 WMEEEEN
77 MEEERT
77 FEEEEE
17T EEERENE
77 TTHEEEE

7!
alnl
minl

Define Custom Colors >

Cancel

*
i(
Hue

.-

ColoriSglid e Blue: EI

Add to Custom Colors

This allows the user to customize the colors they want.

The BACKGROUND COLOR is similar to the Text Color setting; however, it only applies to the
background (Only works if the Transparent setting is off)

Position can be relative or absolute. Relative will allow the customer to align the text —
Top/Middle/Bottom vertically, and/or Left/Middle/Right horizontally. Absolute will allow more
flexibility for the customer as it allows for X and Y positioning of the text.

Font allows the user to select from three different fonts — SimHei, KaiTi, SimSun. The dropdown

menu next to the font controls the size of the text.

Set applies the changes.

www.seada.co.uk
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3.6. TV Wall

. . Matrix PC tool-VM44-v3.0.112
Matrix Swin:hl Advanced Switch | Signal Setting | FineTune:PQ&Position| OSD CTRL TV Wall | Network Setting
Setting TV Wall

Vertical 2 [ ]
Horizontal 2 ]

Available 4 [ ]

Save scene ||Load scene

In the TV WALL tab, the user can design the setup they have in front of them to mirror it in the
software. This allows for some video wall functionalities of the unit — screen stitching. Right-clicking
on the screens will bring up the additional options menu.

. Matrix PC tool-VM44-v3.0.112

Matrix Switchl Advanced Switch | Signal Setting | FineTune:PQ&Position| OSD CTRL TV Wall | Network Setting

Setting TV Wall
Vertical 2 [ ]
Screen 1 Screen 2
Horizontal 2 [ ]
Available 4 |

Screen 3 Screen 4

Save scene || Load scene

Screen Stitching

Cancel Stitching

Input Select >
Output Select >
Output Type >
Output Format >
Horizontal adjust

Vertical adjust

Sync lock

e Screen Stitching - This combines the selected screens into one and displays the selected
input across all of the stitched screens. For example, in the setup below 2x2, if all of them
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are stitched, then the input selected by the user will be displayed across all of the 4 screens
(Note: this is not the same as duplicating a single input on each output)

e Cancel Stitching — This will undo the stitching and will revert to the screens being individual.

e Input Select — Similarly to the video routing matrix, this allows the user to control which
output is displayed on which screen (Note: Selecting an input on any of the screens when
stitched will display it on the stitched screen and not on the individual screen)

e QOutput Select — The user can control which screen should be mapped to which output

e OQOutput Type — Allows the user to adjust the type of the output — HDMI, VGA, HDMI etc.

e QOutput Format — Controls the resolution of the output

e Horizontal adjust — Lets the user adjust the horizontal position of the screen

e Vertical adjust — Lets the user adjust the vertical position of the screen

Setting
Vertical 2 [ |
Horizontal 2 [ ]

The user can save the designed scene (preset) and load it later via the Load
Scene and Save Scene dropdown menu. This allows for easier switching Available 4 7
between layouts — for example a stitched layout, a layout of 2x2 individual |
screens, a 2-screen stitching with 2 individual screens etc.

Set ” Read I

| Save scene I | Load SCEHEI

3.7.Web Control

(1) Condition: do not know the matrix IP address: Click on the Network Settings
page, and then click Search Device, and then select the device that found, click Open
Website to open the web control web site, or can input the IP on the web browser,
then enter the username: admin Password: admin, then can control the matrix switch

functions via website;

NOTE: The computer IP and matrix IP must be in the same segment and the same
local area network; For example, the matrix’s IP is 192.168.1.xxx, then the computer
IP must be 192.168.1.yyy; Otherwise need to change the matrix’s IP or the
computer’s IP

www.seada.co.uk
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Note: the browser must support HTML5 feature, which must be IE10 and above;

Il Matrix PC tool-v1.0.628 (B

Matrix Switch | Signal Setting | FineTune:PQ&Position| OSD CTRL | TV Wall | UART Setting. Network Setting |

& Select config port

Search List (Click device to load configuration) ‘é‘ Port 0 Port 1 Port 2

Device Name IP Address MAC Address Version Baud Rate 9600
USR-K3 192.168.0.116 D8B04CC02375 3009 Parity/Data Bit/Stop Bit |None &= m

Stream Control

N[~
w
[y
4 4

Device Port 3
2 . PC Port
[Search Devnce] [Open Websnte] [Load Default] 2
192.168.0.201
Basic config Motk Moc TCP Server v

6432 Device Name |USR-K3 ¢ t'co
0 MAC Address |D8 B0 4C C0 23 75 P Senver style Transparent transmis ¥
IP Type Auto IP(DHCP) o i None v

admin LEREY 192.168. 5 . 1 Sync BaudRate(RFC2217 similar)

Save Config Save Config

()

v

(2) Condition: know the matrix IP address: Input the IP on the web browser, then enter the
username: admin Password: admin, then can control the matrix switch functions via
website;

When successfully connected following interface should appear:
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Route switch is the same as in the PC Tool.

1- switch language to Chinese (to switch back to English click again)

2 — Chose the Work Mode and Audio Control

3 — Set all outputs on one input, save layouts and recall them as well as reset the device.
4 — Read an input signal type

5 — Read an output, change the type and set a format

IP Config

In ‘IP Config’ tab you can change all ip configurations:

Matrix Control parameter

IP Config IR Static IP ~
static 1p: (N KEHE [N

www.seada.co.uk
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4. Front Panel
Input/Output Buttons

Video/Audio Select Buttons
Type

Format

Recall

Save
>

Enter

4.1.LCM display
LED light flashing once when device receives a valid key pressing.

Continuous key pressing should be within 5 seconds, and the LCM screen will show the video route
info if timeout happens.

LCM screen can show two lines which consists of 16 characters each.
Some key words information as below:

V: Video route info;

A: Audio route info;

T: Type;

F: Format or resolution;

4.2. Audio Input Select (Default: Inner)
Keys operation: AUDIO + INx + — + ENTER

Description: Select audio type: Inner or L/R.

Display: (LED light flashing once when a valid key pressed)

1. Press AUDIO, then the LCM screen will show function menu
S|E|T I {N|P|U|T AJU|D|I |O
PIR|E|S|S I | N 1 2 3 4
2. Press INx to select which input port will be set, and the LCM screen will show the current

setting first.
3. Press — to change the setting (Inner or L/R).

4, Press ENTER to take effect.

www.seada.co.uk
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4.3. Output Audio Select (Default: Inner)
Keys operation: AUDIO + AUDIO+ — + — + ENTER

Description: Select which audio will be controlled in 4.4 Audio Switch and 4.6 Video + Audio Switch.

Display (LED light flashing once when a valid key pressed):

1. Press AUDIO, then the LCM screen will show function menu
S|E|T I {N|P|U|T AJU|D|I |O
PIR|E|S|S I | N 1 2 3 4

2. Press AUDIO again, then the LCM screen will show function menu

S|E|T O|U|T|P|U|T AlU|D|I|O

PIR|E|S]|S <|- - >
3. Press — the LCM screen will show the current setting.
4, Press — to change the setting value (Inner or L/R or Both).
5. Press ENTER to take effect.

4.4, Audio Switch
Keys operation: INx + AUDIO + OUTx [ + OUTX2 + OUTX3 + OUTX4] + ENTER

Description: Switch input audio port x to audio output port X1[X2] [X3] [X4]. And the output port
NUM can be 1 to 4.

Display (LED light flashing once when a valid key pressed):

1. Press INx as audio input port
2. Press AUDIO, then the LCM screen will show current audio route information
3. Press X1[X2] [X3] [X4] keys as audio output ports, then the input of outputX1[X2] [X3] [X4]
will show as ‘>XX’
4, Press ENTER to switch the input, and the LCM screen will show the latest video route
information.

A | N | : 1 2 3 4

O|U|T|: 1 2 3 4

Note: The output audio may be Inner or L/R or Both according to the user’s setting in 4.3 Output
Audio Select.

www.seada.co.uk
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4.5.Video Switch
Keys operation: INx + VIDEO + OUTX1 [ + OUTX2 + OUTX3 + OUTX4] + ENTER

Description: Switch input video port XX to video output port X1[X2] [X3] [X4]. And the output port
NUM can be 1 to 4.

Display (LED light flashing once when a valid key pressed):

1. Press INx as video input port
2. Press VIDEO, then the LCM screen will show current video route information
3. Press X1[X2] [X3] [X4] as video output port, then the input of output X1[X2] [X3] [X4] will
show as ‘>XX’
4, Press ENTER to switch the input, and the LCM screen will show the latest video route
information.

Vv | N |: 1 2 3 4

O|U|T 1 2 3 4

4.6.Video + Switch
Key operation: INx + OUTX1 [ + OUTX2 + OUTX3 + OUTX4] + ENTER

Description: Switch input Audio + Video port XX to Audio + Video output port X1[X2] [X3] [X4]. And
the output port NUM can be 1 to 4.

Display (LED light flashing once when a valid key pressed):
1. Press INXX as input port, then the LCM screen will show current video route information

2. Press X1[X2] [X3] [X4] as output port, then the input of outputX1[X2] [X3] [X4] will show
as’ >XX’

3. Press ENTER to switch the input, and the LCM screen will show the latest video route
information.

Y I INJ:| |1 2 3 4

Note: The output audio may be Inner or L/R or Both according to the user’s setting in 4.3 Output
Audio Select.

www.seada.co.uk
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4.7. Input Type Setting
Keys operation: TYPE + INXX + —+ ENTER

Display:
1. Press down TYPE, shows as follows:

T S|E|T I IN|/|O|U|T

TIY|P|E

2. Press down INXX as input port, then will show the current type of the input port

T I [ N|: 1

TIY|P|E|: C/IV|B|S

3. Press — 1 or more time to change the input type (DVI/VGA/YUV/CVBS)
4, Press ENTER to set the input type

4.8. Output Type Setting
Keys operation: TYPE + OUTXX + — + ENTER

Display:
1. Press TYPE, show as follows

T SIE|T I [N|/|O|JU|T

TIY|P|E

2. Press OUTXX as output port, then will show the current type of the output port

T O|U|T|: 1

T|Y|P|E]: C|V|B]|S

3. Press — 1 or more time to change the input type (HDMI/DVI/VGA/YUV/CVBS)
4, Press ENTER to set the output type

www.seada.co.uk
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4.9. Output Resolution Setting
Keys operation: FORMAT + OUTXX + — + ENTER

Display:
1. Press TYPE, shows as follows

F S|E|T O|U|T

F|O MIA|T

2. Press OUTXX as output port, then will show the current resolution of the output port

F O|U|T 1

FI{M|T 1 0|0(x|1(2|0|0

3. Press — one or more times to change the output resolution

(1024x768/1280x1024/1360x768/1280x720 1600x1200/1920x1080/1680x1050)

4, Press ENTER to set the output resolution

4.10.

OR: RECALL+OUTXX+ENTER

Recall
Keys operation: RECALL+INXX+ENTER

Description: Load the audio and video route info of mode XX

NOTE: (Only 8 modes supported via front panel, but it can be max to 32 modes via PC Software) :

IN1-Mode 1
IN2 — Mode 2°
IN3 — Mode 3
IN4 — Mode 4
OUT1 - Mode 5
OUT2 — Mode 6
OUT3 — Mode 7

OUT4 — Mode 8

www.seada.co.uk
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4.11. SaveAs
Key operation: SAVE + INXX + ENTER

OR: SAVE + OUTXX + ENTER

Description: Save current audio and video route info to mode XX

NOTE: (Only 8 modes supported via front panel, but it can be max to 32 modes via PC tool) :
IN1-Mode 1

IN2 — Mode 2°

IN3 —Mode 3

IN4 — Mode 4

OUT1 - Mode 5

OUT2 — Mode 6

OUT3 —Mode 7

OUT4 — Mode 8

www.seada.co.uk
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5. Command Lines

Save the layout (matrix switcher)

Instruction Format
(ASCII) X,S
Function To save the current displaying status as a preset layout for future recall
Parameters X The layout ID (1-32)

[Example] 3,5
To save the current displaying status as layout 3

Load the layout (matrix switcher)

Instruction
Format (ASCII)
X,R
Function Recall the preset layout
Parameters X The layout ID (1-32) which need to be loaded.

[Example] 6, R
To load the 6th layout

Switch one input signal to all outputs

Instruction Format
(ASCII)
X,Y
Function T switch the video and audio of one input to all outputs at the same time
Parameters X The Input ID (1-4)

[Example] 2,Y
To output the video and audio from input 2 to all 4 outputs at the same time

www.seada.co.uk
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Switch video/audio from one input signal to one output

Instruction Format
(ASCII) a,b,Vv

Function To switch the video of one input to one output, no audio switch

a The Input ID (1-4)

Parameters
b The Output ID (1-4)

Instruction Format
(ASCII) a,b,A

Function To switch the audio of one input to one output, no video switch
a The Input ID (1-4)
Parameters
b The Output ID (1-4)

Instruction Format
(ASCII) a,b,Y

Function To switch the video and audio of one input to one output at the same time
a The Input ID (1-4)
Parameters
b The Output ID (1-4)
[ Example]
2,3,V

To output the video from input 2 to output3, no audio change on output3

2,3,A
To output the audio from input 2 to output3, no video change on output3

2,3)Y
To output the video and audio from input 2 to output3 at the same time

www.seada.co.uk
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Switch multi input signals to multi outputs

a,b,c,d,V a,b,c,dA

a,b,c,d,Y
a,b,c,d,e,f,vV
Instruction Format
(ascy  |pecdefAabcedety
a,b,c,d,e fg,hV ab,c,de,fqg,hA
a,b,c,d,e f,g,hY
Biratian T switch the video only (V) or audio only (A) or video & Audio (Y) of the

multi inputs to multi outputs
Parameters a,c,.e,g | The Input ID (1-4)

b,d,f,h | The Output ID (1-4)

[Example] 1,2,2,3,3,4,4,1,Y
To output the video and audio from input 1 to output2 at the same time
To output the video and audio from input 2 to output3 at the same time
To output the video and audio from input 3 to output4 at the same time
To output the video and audio from input 4 to outputl at the same time

Auto match all inputs to all outputs

Instruction Format
(ASCII) All;

Function T switch inputs 1,2,3,4 to outputs 1,2,3,4 respectively

[Example] All;
Outputl shows inputl, output2 shows input2, output3 shows input3, output4 shows input4

Serial communication commands format for TV Wall:

e Command Head

Command Index
Command length
Command Body

Check-Sum

e Command Tail

www.seada.co.uk
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TV Wall Save Scene:

Format: 7B 7B C7 01 (save as scene...) (check sum) 7D 7D
Examples:

7B 7B C7 01 00 B8 7D 7D (save as scene 1)

7B 7B C7 01 01 B9 7D 7D (save as scene 2)

7B 7B C7 01 09 C1 7D 7D (save as scene 10)

7B 7B C7 01 0A C2 7D 7D (save as scene 11)

Tv Wall Load Scene:

Format: 7B 7B C8 01 (save as scene...) (check sum) 7D 7D
Examples:

7B 7B C8 01 00 B9 7D 7D (load scene 1)

7B 7B C8 01 01 BA 7D 7D (load scene 2)

7B 7B C8 01 09 C2 7D 7D (load scene 10)

7B 7B C8 01 OA C3 7D 7D (load scene 11)

Note:

When CMD Body value increases or decreases CMD Check-Sum goes accordingly.

6. Troubleshooting

6.1. No Connection
6.1.1.Ensure the G44 is powered up
6.1.2.Ensure the PC and G44 at the same IP group
6.1.3.Ensure the IP address is correct for G44

6.1.4.1P address of each device will be shown on screen when no video input is applied.

6.2. No Output
6.2.1.Ensure the video source is on
6.2.2.Ensure the video source device sends the signal out (G44 INPUT statue LED light will be
on if input video signal presents)
6.3. Black screen
6.3.1.Ensure the G44 and screens are powered up
6.3.2.Ensure the connection to screens are OK
6.3.3.Ensure the screens on correct channel (DVI or HDMI or VGA)

6.3.4.Ensure that the inputs are assigned correctly (i.e. Input 1 on Output 1, Input 2 on Output
2 etc

www.seada.co.uk
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